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SuiteProfiler Documentation
SuiteProfiler is supported by 2 documents:
• SuiteProfiler User Guide is a "learn by reading" reference document
• SuiteProfiler Quick Start Guide is a "learn by doing" document
This document is the SuiteProfiler User Guide.

Introduction to SuiteProfiler
SuiteProfiler is a simple and powerful Mac application that allows you to create a Suite of
custom color-accurate ICC Profiles, aka Color Map Profiles.
A Suite of Color Map Profiles supplements the profiling environment of an existing full
color ICC Profile. This empowers you with the tools to easily profile and present any
digital image in a variety of ways without image editing.
Each Color Map Profile is derived from a user defined Color Map. A Color Map specifies
how Luminance Input is mapped to Color Output. A Color Map Profile prints or converts
an image using the color mapping defined by the Color Map.
Color Map Profiles can be applied to both color and grayscale digital images in any
system and application environment which supports color profiling.
In SuiteProfiler:
• You design a device independent Color Map
• You preview the effects of the Color Map on your image
• You export a device dependent Color Map Profile derived from the Color Map
• You can create a Suite of Color Map Profiles from a variety of Color Maps
Results:
• You have a Suite of Color Map Profiles for a unique profiling environment
(e.g. printer, ink and paper combination)
• You use the Color Map Profiles to soft proof and print images in any imaging
application that supports profiling (e.g. Adobe Photoshop)
Example:
• You create a Suite of metallic-looking Color Maps for copper, bronze, and silver
• You preview the effects of the Color Maps on your own images
• You export a Suite of three metallic-looking Color Map Profiles for printing on
Epson Glossy Paper using an Epson Printer
• You use the Color Map Profiles in Adobe Photoshop to soft proof and print metallic
renditions of any of your color or grayscale images

Overview of SuiteProfiler
SuiteProfiler empowers the user to create custom ICC Profiles, aka Color Map Profiles.
Each Color Map Profile is derived from a Color Map created in SuiteProfiler and a full
color Display or Printer Class Profile, aka Source Profile. Color Map Profiles can be used
in any Application on any Operating System which supports ICC Profiling.
A suite of Color Map Profiles created by the user supplements a Source Profile with a
range of presentation and conversion possibilities without image editing. Color Map
Profiles can be applied to both color and grayscale images.

Creating custom Color Map Profiles with SuiteProfiler is a two step process. Each step is
performed in one of the Tabs in the SuiteProfiler document window (pictured above).
• The "Color Map" Tab is the first step and supports the development of a Color
Map. A Color Map is a SuiteProfiler application document.
• The "Color Map Profile" Tab is the second step and supports the creation of a
color-accurate Color Map Profile. This is derived from the Color Map and a full color
Source Profile selected by the user. A Color Map Profile is exported from SuiteProfiler
and then used in any Application which supports color profiling.
In the first Tab, the user creates a Color Map which defines a device independent color
scale. The Color Map defines the mapping of Luminance Input values (represented as
Locations on the scale) to Color Output values. The user creates points of color along
the scale by defining Color Pens. The color scale is defined via interpolation between the
defined Pens. A Color Map can support any range of colors defined by the user.
In the second Tab, the user creates and exports a Color Map Profile from an existing full
color Source Profile and the current Color Map. The Color Map Profile is device
dependent. It is intended for use in the same profiling environment as the Source Profile.
The Color Map Tab supports the usual App document commands for Color Maps. The
Color Map Profile Tab supports commands for Source Profile selection, Color Map
Profile calibration and Color Map Profile exportation.

SuiteProfiler Installation
The first time SuiteProfiler is launched the SuiteProfiler Install Panel is presented. The
user should follow the instructions to install the application Library folder along with three
subfolders. This only needs to be done once for all versions of SuiteProfiler.

The user is instructed to install the following application folders:
• ~/Library/SuiteProfiler
• ~/Library/SuiteProfiler/ColorMaps
• ~/Library/SuiteProfiler/Measurements
• ~/Library/SuiteProfiler/Scales
Sample files are installed in the three subfolders in the "SuiteProfiler" folder.
The ColorMaps subfolder is the location for storage of application Color Maps. The
subfolder is installed with 10 sample Color Maps which can be used or edited.
The Measurements subfolder is the location for storage of calibration measurement
files. The subfolder is installed with 3 sample files. The sample files are examples of
measurement file formats allowed for reading and writing measured calibration data.
The data in the sample files are meant to be used for calibration.
The Scales subfolder is the location containing 2 color scales. There is a 21 step scale
and an 11 step scale. The scales are used for printing and measuring Luminance data
for Color Map Profile Calibration.
The user can choose to create and install a different set of folders but these are the
recommended ones.
Once this process is completed the Install Panel will not appear again automatically. The
user can still bring up the Panel and perform installation again. This is not necessary but
the option does exist in case the user wants to install a different set of folders (directory
locations).

SuiteProfiler Preferences
The Preference Panel has 6 application preferences grouped according to use. The
initial settings are the recommended settings.

Auto Save Color Maps:
This preference specifies if Color Maps are automatically saved when changes occur.
The user only needs to name and save each new Color Map once.
New Color Map Pen Count:
This preference specifies the initial Pen count for a new Color Map. This number is
limited to a range of 2 to 6 Pens.
Source Profile List Count:
This preference specifies the maximum number of Source Profiles that will appear in the
pulldown on the Color Map Profile Tab. This number is limited to the range of 3 to 20.
Include Private Source Data:
This preference specifies if Private Data Tags embedded in the Source Profile are to be
included in Color Map Profiles. This should be checked for Source Profiles used for RIP
printing. The default is unchecked for Source Profiles used for Driver printing.
Profile Extension:
This preference specifies the file extension for the exported Color Map Profile.
Retain Current Preview Image:
This preference specifies if the current image in the Preview Panel should be retained
for later SuiteProfiler launches. If a user image is loaded into the Preview Panel, a copy
of the image is saved for future use.

SuiteProfiler Image Previewing
The Preview Panel displays an Image. The Panel's title displays the Image name and
Color Map name. The Image is presented in the Preview Panel in one of 2 modes:
• Preview mode
• Image mode
In Preview mode, the Image is previewed using the current Color Map. Image
previewing is enabled and automatically updated with changes to the Color Map. The
"Preview > Show Image Preview" menu item puts the Preview Panel in Preview mode.
In Image mode, the actual Image is displayed. Image previewing is disabled and the
Image remains unchanged when the current Color Map changes. The
"Preview > Show Image" menu item puts the Preview Panel in Image mode.
Clicking the Image toggles between the Preview and Image modes. The user must
manually change from Image to Preview mode to enable auto updating of the Image.
Each Color Map maintains its own mode. As the user moves amongst multiple Color
Maps, Image previewing will change based on the mode of the current Color Map.

The user may load a bitmap image into the Preview Panel at any time. The user may
also drag-and-drop a bitmap image onto the Preview Panel image. Valid image formats
include .bmp .gif .jpg .png .psd .tga and .tif file extensions. Images may be RGB or
Grayscale, 8 or 16 bit color data. The user may revert to SuiteProfiler's default image as
well.
The Preview Panel may not composite and display the Adobe Photoshop image file
format (with ".psd" file extension) with multiple layers or alpha channels as the
Photoshop application intends. See Troubleshooting for more details.

Image Previewing Commands
The commands in the Preview menu are used for Image previewing.

The first 2 menu items apply to Preview Image files:
• "Load Preview Image..." presents a Load Panel to select a bitmap Image
to load into the Preview Panel,
the "Retain Current Preview Image" preference determines if the Image is
retained for the future, across multiple SuiteProfiler launches
• "Revert to Default Preview Image" sets the Image to the default image
supplied by SuiteProfiler
The next 2 menu items apply to the Preview Image:
• "Show Image Preview" displays the Image in Preview mode
• "Show Image" displays the Image in Image mode
• these menu items apply to the current Color Map only
The last 2 menu items apply to the Preview Panel:
• "Hide Preview Panel" hides the Preview Panel for all Color Map windows,
while the Preview Panel is hidden the menu item is replaced with
"Show Preview Panel" which shows the Preview Panel
• "Zoom Preview Panel" resizes the Preview Panel to it's maximum size
or to it's previous size if already at it's maximum size
Clicking on the Preview Image toggles between Preview mode and Image mode:
• clicking the Image in Image mode changes to Preview mode
• clicking the Image in Preview mode changes to Image mode
• mode change applies to previewing for the current Color Map only

SuiteProfiler Color Maps
The SuiteProfiler application document is a Color Map. Color Maps are created in the
Color Map Tab of the document window.
A Color Map defines the mapping of Luminance Input (represented by Locations on the
Color Map) to Color Output. Color Output includes both Luminance and Chrominance
values.
A Color Map is an opaque, uniform color scale defined by a set of 2 or more Color Pens.
The Pens are defined and edited in the horizontal Color Pen Channel above the Color
Map. A Color Map can be defined by any number of Pens defining any range of colors.

Each Pen has a Location in the Channel. Pen Location specifies the Luminance Input.
Pen Color specifies the Color Output. The range of colors in a Color Map is defined
through interpolation of the Colors defined by the Pens.
The Color Pen Channel consists of integral Locations ranging from 0 to 100. These
Locations represent Luminance Input values in the Color Map.
Editing of Pen Location and Color is performed on the Selected Pen. The Selected Pen
is indicated visually as a "fat" Pen. The Pen's Location is displayed in the "Selected Pen
Location" box. The Pen's Luminance is displayed in the "Selected Pen Luminance" box.
The Selected Pen's Color is viewed and edited in the accompanying Colors Panel. The
Colors Panel displays the editable Lab color values for the Selected Pen.
A single Color Map can be used to create many Color Map Profiles, each derived from a
different Source Profile. Source Profiles are any ICC Profiles defined for Display or
Printer use. See Color Map Profiles for more details.

Color Map Commands
The following commands in the File menu are available from the Color Map Tab.

The first 3 menu items apply to Color Map documents:
• "New" creates a new unsaved Color Map document with an Untitled name,
the "New Color Map Pen Count:" preference determines the initial Pen count
• "Open..." presents the Open Panel to open an existing Color Map document
• "Open Recent" maintains a list of recently opened Color Map documents
The second 4 menu items apply to the current Color Map document:
• "Close" closes the current Color Map document and window
• "Save..." presents the Save Panel for an unsaved document, this becomes
"Save" after the initial save when the document is named,
this allows saving of the current Color Map document manually
• "Save As..." presents the Save Panel for the current document which allows
naming of the Color Map to be saved
• "Duplicate" makes a copy of the current Color Map document and window
The next 5 menu items are disabled and not available from the Color Map Tab. These
are described in the following section on Color Map Profile Commands.
The last 3 menu items apply to printing:
• "Page Setup..." presents the Page Setup Panel for printing
• "Print Color Map Tab..." presents the Print Panel with an image of the
current Color Map Tab
• "Print Color Map..." presents the Print Panel with an image of the
current Color Map and Pens

Color Pens
The following operations can be applied to a Color Pen:
Selecting a Pen
A Pen is selected by clicking on the Pen. Pens are also selected via Tab and Back Tab
keys. Tabbing cycles from one Pen to the next. The currently Selected Pen is displayed
as a "fat" Pen. The Colors Panel is displayed when a Pen is selected, hidden when not.
Moving the Selected Pen
A Pen's Location is changed by moving the Pen horizontally within the Color Pen
Channel by dragging it with the mouse. The Selected Pen can also be moved via the left
and right arrow keys. Each arrow keystroke moves the Pen by a single Location step.
Pressing the shift key with an arrow key moves the Pen in increments of 10 steps.
Updating the Selected Pen
The Colors Panel is available to update the color of the Selected Pen. This can be done
by selecting a color on the color wheel or sliders. The color can also be edited using the
Lab values and steppers at the bottom of the Colors Panel. A color change in a Pen
changes the Color Output. The updated Pen Color is reflected in the Color Map.
Deleting the Selected Pen
The Selected Pen can be deleted by clicking and dragging the Pen downward over the
Color Map. When dragged down, the disappearing cursor (puff of smoke) appears and
the Color Map reflects the change. The Pen is deleted when the mouse button is
released over the Color Map. If the mouse is moved back into the Color Pen Channel,
the Pen is not deleted, but it may be moved. A deleted Pen is reflected in the Color Map.
Adding a Pen
A new Pen can be created by clicking in an empty part of the Color Pen Channel above
the Color Map, between the end point Pens at Locations 0 and 100. The new Pen is
created at the point of the click. A new Pen adopts its color from the Color Map at the
point where it is added.
End Point Pens
The two Pens at Locations 0 and 100 are fixed at those Locations. The Color of the
Pens can be updated, however these Pens cannot be moved or deleted.

Color Pen Linearization
Linearization refers to the process of aligning a Pen's Luminance with a Pen's Location.
The idea is to create a Color Map which will print Luminance values on a linear scale in
either ascending or descending order. The linear Luminance scale is defined by the end
point Pens. Linearization is optional.

Color Map Linearization is provided through a pair of buttons on the Color Map Tab.
These buttons are used to align Luminance and Location for the Selected Pen. These
buttons are provided as a convenience to make quick calculations when a linear
Luminance scale is desired. Linearization can be performed in 2 different ways.
The "Linearize to Luminance" button in the "Selected Pen Location" box moves the Pen
by changing the Pen's Location based on the Pen's Luminance. The Pen is relocated so
the Luminance is linearized at the new Location within the overall Luminance scale.
The "Linearize to Location" button in the "Selected Pen Luminance" box sets the Pen's
Luminance based on the Pen's Location. The Pen is updated so the Luminance is
linearized at the current Location within the overall Luminance scale.
Both "Linearize to" buttons are disabled when the Selected Pen's Luminance and
Location are linearized. The buttons are enabled when the Pen is not linearized.
Linearization is also performed by the Linearize menu items in the Pen menu.

Color Pen Undo / Redo
All Pen operations used to edit the Color Map can be undone and redone.

Color Pen Commands
The commands in the Pen menu are available from the Color Map Tab.

The first menu item applies to a new Color Pen:
• "Add New Pen" adds a new Pen in the center of the largest
gap between defined Pens and then selects the new Pen
The second 2 menu items apply to the selected Color Pen:
• "Delete Pen" deletes the selected Pen and selects the nearest Pen
• "Deselect Pen" deselects the selected Pen and hides the Colors Panel
The next 2 menu items apply to the selected Color Pen:
• "Linearize Pen Luminance to Location" adjusts the selected Pen Luminance
so it is linearized within the Luminance range defined by the outer Pens
• "Linearize Pen Location to Luminance" moves the selected Pen to the
Location that linearizes it's Luminance within the Luminance range defined
by the outer Pens
• "Linearize Pen Luminance to Location" is the same as the
"Linearize to Location" button on the Color Map Tab
• "Linearize Pen Location to Luminance" is the same as the
"Linearize to Luminance" button on the Color Map Tab
The next 2 menu items apply to the selected Color Pen:
• "Invert Pen Luminance" inverts the Luminance of the selected Pen
• "Invert Pen Color" inverts the Lab color channels of the selected Pen
The next 2 menu items apply to all the defined Color Pens:
• "Invert All Pen Luminances" inverts the Luminance of all the Pens
• "Invert All Pen Colors" inverts the Lab color channels of all the Pens
The last menu item applies to all the defined Color Pens:
• "Flip All Pen Locations" moves all the Pens to the opposite Location on
the color scale by subtracting each Location from 100

Document Window Commands
The commands in the Window menu are used to manage the Color Map document
windows.

The first 2 menu items apply to the current document window:
• Minimize minimizes the current document window
• Zoom resizes the current document window to it's maximum size
or to it's previous size if already at it's maximum size
The next 3 menu items apply to all document windows:
• Bring All to Front displays all non-minimized document windows on top
of all other applications on the screen
• Bring Previous to Front brings the geographically previous non-minimized
document window forward on the screen
• Bring Next to Front brings the geographically next non-minimized
document window forward on the screen
The last set of items is a variable length list of the currently opened Color Map
documents. These are listed alphabetically by name. The check mark indicates the
current document. A diamond indicates a minimized document window.
The "Bring Previous to Front" and "Being Next to Front" menu items are only
enabled when there are two or more non-minimized document windows present.

SuiteProfiler Color Map Profiles
A Color Map Profile is derived from the current Color Map and a pre-existing full color
Source Profile selected by the user. A Source Profile must be a Display or Printer Class
Profile which supports either the RGB or the CMYK color space.
A Color Map Profile is a color-accurate ICC Profile which supports the color mapping
defined by the current Color Map. The Color Map Profile should be used in the same
profiling environment as the Source Profile. For example, it should only be used with the
same printer, ink and paper combination as the Source Profile, if used for printing.
When a Color Map Profile is applied to a digital image, the Color Map used to define it is
applied to the image. Color Map Profiles can be used for image printing and/or image
conversion.
Color Map Profiles are created and exported from the Color Map Profile Tab in the
document window via the "File > Export Color Map Profile..." menu item.

The "Source Profile" box displays the Source Profile pulldown. Source Profiles are
selected and added to the pulldown via the "File > Select Source Profile..." menu item.
The pulldown maintains a list of selected Source Profiles for future use.
The "Color Map Profile" box displays the Description and the Copyright text which will be
included in the exported Color Map Profile.
The "Color Map Profile Calibration" box displays the Luminance scale "Defined" by the
Color Map. The "Measured" radio button allows the user to enter measured Luminance
values for the purpose of exporting a calibrated Color Map Profile. The "Normalized"
radio button displays the measured Luminance values normalized to the Luminance
range defined by the Color Map. See Color Map Profile Calibration for more details.

Color Map Profile Commands
The following commands in the File menu are available from the Color Map Profile Tab.

The first 4 menu items apply to Color Map documents and are described in the previous
section on Color Map Commands.
The next 3 menu items are disabled and not available from the Color Map Profile Tab.
See Color Map Commands for details.
The next menu item applies to Source Profiles:
• "Select Source Profile..." presents a Select Panel to select an ICC Profile
to be used as a Source Profile, the Profile is added to the Source Profile pulldown
The next 2 menu items apply to Color Map Profiles:
• "Export Color Map Profile..." presents an Export Panel to export the
Color Map Profile derived from the current Color Map and Source Profile
• "View Profile in ColorSync Utility" launches Apple's ColorSync Utility with
the last exported Color Map Profile, see "Examine Color Map Profile" in
the Quick Start Guide for details
The next 2 menu items apply to Calibration Data Files:
• "Read Calibration Data..." presents a Read Panel to read a file of calibration
measurement data saved in a simple format,
the 3 sample files in the "~/Library/SuiteProfiler/Measurements" are examples
of the file formats readable by this command
• "Write Calibration Data..." presents a Write Panel to write the calibration
measurement data from the current Color Map Profile Tab to a file in a list format
The last 3 menu items are described in the previous section on Color Map Commands.
The last menu item is disabled and not available from the Color Mp Profile Tab.

RIP Printing Support For Color Map Profiles
SuiteProfile supports the generation of Color Map Profiles for RIP printing environments
as well as standard Driver printing environments. Typically, Source Profiles used by RIP
software contain Private Data Tags, or non-ICC profile tags, which specify ink usage for
the RIP printing software.
When a Source Profile contains Private Data Tags, SuiteProfiler displays the tag count
as part of the Source Profile information. For example, the ImagePrint Source Profile
selected below indicates that there is one Private Data Tag.

The "Include Private Source Data:" Preference specifies if Source Profile Private Data
Tags are included in the exported Color Map Profiles. When the Preference is checked,
Color Map Profiles will be generated for use in the RIP printing environment. That is,
Color Map Profiles will contain the Private Data needed for RIP printing.

When the Preference is unchecked, exported Color Map Profiles will not include the
Source Profile Private Data Tags. This is the default for Color Map Profiles used in
Driver printing environments.

Color Map Profile Calibration
In practice, a Color Map Profile derived from a given Source Profile and Color Map may
not render it's Luminance scale exactly as defined. This is typically true for Profiles
derived from Source Profiles used for printing. The purpose of Calibration is to
guarantee that a Color Map Profile displays and/or prints Luminance values correctly.
Calibration refers to the process of adjusting a Color Map Profile so it accurately renders
the Luminance values specified by the defining Color Map.
The user first prints and measures sample Luminance values rendered by an existing
Color Map Profile. Next the user selects the "Measured" radio button in the Color Map
Profile Calibration box, then enters the measured Luminance values in the text fields.
Measured data can be Density values. If so, they will be converted to Luminance values.

When the Color Map Profile is exported, SuiteProfiler corrects the difference between
the measured and expected Luminance values to the Color Map Profile. The result is a
Profile which renders it's Luminance scale as accurately as possible.
The Luminance scale of the defining Color Map does not have to be linear to Calibrate
the Color Map Profile. Calibration can be applied to a Color Map Profile with either an
ascending (monotonically increasing) or a descending (monotonically decreasing)
Luminance scale.
If the Luminance scale is non-monotonic, Color Map Profile Calibration is disabled in
SuiteProfiler. That is, the "Measured" and "Normalized" radio buttons are disabled.
A reflective densitometer or similar device is needed to measure printed Luminance
values for calibrating Color Map Profiles for printing. If a measuring device is not
available, Calibration can be skipped. Calibration is optional.

Color Map Profile Calibration (continued)
For example, say the color defined at Location 50 in a Color Map has a Luminance
value of 50. Then the Color Map Profile derived from the Color Map and a Printer
Source Profile should print with a normalized Luminance of 50.
To guarantee this the user prints and measures the Luminance values of a set of color
samples using the Color Map Profile. Calibration will correct any inaccuracies and a
newly exported Color Map Profile will print as intended.
The normalized values of the measurement data is displayed when the "Normalized"
radio button is selected. These values can be compared to the "Defined" values to see
the difference between the defined scale and the printed scale.
For example, at Location 50, the "Defined" Luminance is 50.00, the "Measured"
Luminance is 49.11, and the "Normalized" Luminance of 47.84. Calibration will correct
the difference between the "Defined" and "Normalized" Luminance values.

Two sample color scales were installed by SuiteProfiler during the installation process.
These reside in the "~/Library/SuiteProfiler/Scales" folder. Use these to print samples
using a Color Map Profile. Then measure the samples and enter the data in the Color
Map Profile Calibration "Measured" fields. There are 21-step and 11-step scales.

Troubleshooting
SuiteProfiler Image Previewing
SuiteProfiler's Preview Panel displays images the same way as Apple's Finder and
Preview applications. This display is also seen in the "Load Preview Image..." Panel.
Apple's software composites and displays Photoshop image files with multiple layers and
alpha channels differently than intended by the Adobe Photoshop application. As a
result, Photoshop image files may not display in SuiteProfiler as they should, that is, as
Photoshop intends.
This is an issue only for the Photoshop image file format indicated by the ".psd" file
extension.
SuiteProfiler attempts to detect this imaging discrepancy for ".psd" image files. When it
does, the image is not displayed and the user receives a warning from the Preview
Panel.
Note that images with multiple layers and alpha channels in ".tif", or other bitmap image
files, are displayed correctly in Apple software. SuiteProfiler only checks ".psd" files for
multiple layers and alpha channels.
Suggestions for successful display of ".psd" image files:
• remove all alpha channels, including layer masks, and flatten the ".psd" image
• save the ".psd" image as a ".tif" image file and use that for the Preview Panel

